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1.GETTING STARTED

Please follow these few steps below to get started. For more details go to the page numbers
listed under each step.

1.

2.

10.

11.

12.

Uninstall any previous versions of AutoResp™ software (page 69).
Install the new AutoResp™ software on a PC with Windows 10, 8 or 7 (page 31).

Minimum PC requirements:

CPU Duo Core 2,4 GHz or similar
RAM 4 GB

USB ports 2-5 (system dependent)
Monitor 1024 x 768

Connect the Bluetooth power strip (NETIO) to a grounded wall socket. Connect the USB
Bluetooth dongle to the PC (page 22).

Set up your Witrox instrument(s) (page 13).

For swim tunnel respirometers set up the DAQ-BT instrument(s) (page 17)
Mount your chambers with a pump for flushing and a pump for recirculating the
chamber using a minimum of tubing (page 10). Remember to thermostate your

chamber(s) by placing it submersed in a surrounding (ambient) tank.

Connect all flush pumps to RE1 on the Bluetooth power strip (NETIO) using a power
strip or adapter cable supplied with the system. Connect all recirculating pumps to RE2.

Insert the green hardkey protection (WiBu) dongle (page 44) containing license
information.

Start the AutoResp™ software (page 45).

Do not run any other programs at the same time, neither software delivered with
Loligo™ instruments, nor software from other vendors. Thus, software delivered with
fiber optic instruments and needed for stand alone use, should not be run in parallel
with AutoResp™.

Set up AutoResp™ to the instruments you have by using the Auto Configure button and
chose one of the system (page 4)

For reviewing respirometric data or graphs and for post analysis, load raw data files via
the File menu in AutoResp™ (page 50).

Calculated data is saved in an Excel compatible text file.

Page 3 of 74



T

Loligo’ Systems

2.PACKAGES (DAQ-PACS)

2.1 DAQ-PAC-WF1

This package for measurements of oxygen consumption rates in a single respirometer chamber
includes fiber optic oxygen sensing technology suited for any chamber volume, and equipment
for monitoring water temperature. With optional equipment water temperature can also be
controlled and/or water Oz saturation can be monitored or controlled.

Single chamber

Any chamber volume

Water temperature measurements (regulation optional)

Optional measurements and regulation of ambient water oxygen saturation

NB! Please note that no fiber optic oxygen sensors are included in the package since these
should match the application. More about fiber optic sensors can be found on page 13.

USB cable

—— Power

DAQ-M back DAQ-M front
BlueTooth

_ Recirc pump
-
L
_ Flush pump
G, Fiber optic oxygen probe

Temperature probe
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2.1.1. List of parts

e DAQ-M instrument
o Power cord
o Converter piece (230 V/110V)
o Device connector (2x)

e AutoResp™
o USB MEMORY STICK
o Wibu dongle

e Witrox 1 oxygen instrument for mini sensors
o AC/DC travel adapter (1.5 m)
o USB power cable for PC (1.5 m)
o PT1000 sensor (4W,ClassA, 1.9x40mm, 5 m cable)
o Plastic suitcase (345x285x122 mm)

2.1.2. Optional

For measuring effects of hypoxia/hyperoxia on respiration, we offer an oxygen instrument and
an (DO-SET) accessory kit for injection of N2 or Oz gas.

For oxygen consumption measurements in two chambers, add a Witrox 1 + sensor, or consider
a Witrox 4 + sensors for multiple chambers.

For regulating water temperature, all you need is a TMP-SET accessory kit
(#AC10150/#AC10160).

Page 5 of 74
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2.2DAQ-PAC-WF4

This package for measurements of oxygen consumption rates in up to four respirometer
chambers includes fiber optic oxygen sensing technology suited for any chamber volume, and
equipment for monitoring water temperature. With optional equipment water temperature can
also be controlled and/or water Oz saturation can be monitored or controlled.

1-4 chambers
Any chamber volume

Water temperature measurements (regulation optional)
Optional measurements and regulation of ambient water oxygen saturation

NB! Please note that no fiber optic oxygen sensors are included in the package since these
should match the application. More about fiber optic sensors can be found on page 13.

DAQ-M back

* Recirc pump chamber 1
*" Recirc pump chamber 2

* Recirc pump chamber 3

" Recirc pump chamber 4
G

* Flush pump chamber 1
G,

Flush pump chamber 2

G
" Flush pump chamber 3
G,
" Flush pump chamber 4
G,

USB cable

DAQ-M front Power
BlueTooth

© o
° 2 1 ¥
°
]
Fiber optic oxygen probes
Chamber 1 to 4

Temperature probe
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2.2.1. List of parts

¢ DAQ-M instrument
o Power cord
o Converter piece (230 V/110 V)
o Device connector (2x)

e AutoResp™
o USB MEMORY STICK
o Wibu dongle

e Witrox 4 oxygen instrument for mini sensors
o AC/DC travel adapter (1.5 m)
o USB power cable for PC (1.5 m)
o PT1000 sensor (4W,ClassA, 1.9x40mm, 5 m cable)
o Plastic suitcase (345x285x122 mm)

2.2.2. Optional

For measuring effects of hypoxia/hyperoxia on respiration, we offer an oxygen instrument and
an (DO-SET) accessory kit for injection of N2 or O2 gas.

For oxygen consumption measurements in 5-8 chambers, add a Witrox 4 oxygen instrument +
sensors

For regulating water temperature, all you need is a TMP-SET accessory kit
(#AC10150/#AC10160).
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2.3DAQ-PAC-WF8

This package for measurements of oxygen consumption rates in up to eight respirometer
chambers includes fiber optic oxygen sensing technology suited for any chamber volume, and
equipment for monitoring and regulating water temperature. With optional equipment water
temperature can also be controlled and/or water Oz saturation can be monitored or controlled.

1-8 chambers
Any chamber volume

Water temperature measurements (regulation optional)
Optional measurements and regulation of ambient water oxygen saturation

NB! Please note that no fiber optic oxygen sensors are included in the package since these
should match the application. More about fiber optic sensors can be found on page 13.

* Recirc pump chamber 1

~ Recirc pump chamber 2
G,

" Recirc pump chamber 3

" Recirc pump chamber 4
G

USB cable

Power

DAQ-M front

BlueTooth

@ o
) /i 3 r
o
e
Fiber optic oxygen probes
Chamber 1 to 4

Temperature probe

* Recirc pump chamber 5
@

™ Recirc pump chamber 6
Recirc pump chamber 7

Recirc pump chamber 8

* Flush pump chamber 1

Flush pump chamber 2
Y

* Flush pump chamber 3
G
Flush pump chamber 4
G,

* Flush pump chamber 5
6-

** Flush pump chamber 6

* Flush pump chamber 7

G,
_ Flush pump chamber 8
G,
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2.3.1. List of parts

¢ DAQ-M instrument
o Power cord
o Converter piece (230 V/110 V)
o Device connector (2x)

e AutoResp™
o USB MEMORY STICK
o Wibu dongle

e Witrox 4 oxygen instrument for mini sensors (2x)
o AC/DC travel adapter (1.5 m)
o USB power cable for PC (1.5 m)
o PT1000 sensor (4W,ClassA, 1.9x40mm, 5 m cable)
o Plastic suitcase (345x285x122 mm)

2.3.2. Optional

For measuring effects of hypoxia/hyperoxia on respiration, we offer an oxygen instrument and
an (DO-SET) accessory kit for injection of N2 or Oz gas.

For regulating water temperature, all you need is a TMP-SET accessory kit
(#AC10150/#AC10160).
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3.CHAMBERS

3.1 Static chambers

When using AutoResp™ with horizontal chambers for determining the metabolic rate of
resting/inactive animals, the chamber and pumps must be assembled as indicated in the

diagram below.

——— Tubing

Oxygen probe

Chamber

Water tank

Place the outlet hose just above the water surface for visual check of pump flow and to avoid
siphon water entering the respirometer when the flush pump is turned off!

Avoid excess tubing to limit volume, gas diffusion and surfaces for bio film.

For more info on intermittent resp. principle see page 63.
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3.25wim tunnels

For SWIM-MINI tunnels assembled as indicated in the diagram below.

DAQ-M Tubing

............. BlueTooth
USB cable
Pump cable
Adapter cable

Power cable

Wall outlet — Data cable

d
T

Fiber optic oxygen instrument
Witrox 1

Dipping probe
Controller

Temperature probe

Wall outlet

SWIM-MINI

When using a DAQ-BT instead of a DAQ-M instrument connect the input and output connectors
from the swim tunnel motor controller to the DAQ-BT input and output connectors. For the
PULSE output please use the long data cable. For the analog input please use the short data
cable.

Connect the flush pump to RE1 on the BlueTooth power strip (NETIO) instead of the DAQ-M.
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For large swim tunnels assembled as indicated in the diagram below.

DAQ-M

e —— TUbDING

Back

Front I‘! ------------- BlueTooth
i E« USB cable
. . . 1
M I

—
Pump cable
—  Adapter cable

Power cable

EEEEEEEEEEEEE
(3
e
=)
v

W  Wall outlet — Data cable

Fiber optic oxygen instrument o| &=
Witrox 1 ol B

Controller

Dipping probe Temperature probe

Wall outlet

SWIM-LARGE

When using a DAQ-BT instead of a DAQ-M instrument connect the input and output connectors
from the swim tunnel motor controller to the DAQ-BT input and output connectors.

Connect the flush pump to RE1 on the BlueTooth power strip (NETIO) instead of the DAQ-M.
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4. INSTRUMENTS

4.1Witrox

The Witrox is either a 1 channel (Witrox 1) or 4 channel (Witrox 4) oxygen instrument for
measuring dissolved oxygen using fiber optic mini sensors (optodes) and monitoring
temperature.

NB! Do not use WitroxView software while running AutoResp™.

SETUP

Connect the Witrox instrument to the power adapter by using the USB cable on the backside of
the instrument.

Connect the power adapter to a wall outlet.
Push the Power button, the power LED will turn green. The LINK LED will flash green.

Press the Windows Start button and choose Devices. An overview of the connected devices is
listed.

E=dber]Es

l',j » Control Panel » Hardware and Sound » Devices and Printers » - ‘ﬁ;l ‘ Search Devices and Printers §el |

—~

Add a device Add a printer = - @

1
4 Devices

.&QN’W

Dell 2007FP Generic USE Mass USB Receiver
(Analog) Bluetooth Radio Storage Device

4 Printers and Faxes

|

i

~d
4 o A

-
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Please click on the “Add a device” button.

“\.I)' [ Add a device

Select a device to add to this computer

Windows will continue to look for new devices and display thermn here,

CT-CLIENT13

Bluetooth
< Laptop computer

= -,‘.I Witraox
Bluetooth
Other

Erik Jessen
Bluetooth
Phone

L

What if Windows doesn't find my device?

Click on the Witrox instrument, then click Next.

5 [ addaderice

Select a pairing option

% Create a pairing code for me
The device has a keypad.

| & Enter the device's pairing code Witrox
The device comes with a pairing code, :
Check for one on the device or in the device manual.

< Pair without using a code

This type of device, such as a mouse, does not require a
secure connection.

How can I tell if my device has a pairing code?
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Please choose “Enter the device "s pairing code”, then click Next.

@ [ Add a device

Enter the pairing code for the device

This will verify that you are connecting to the correct device,

q

The code is either displayed on your device or in the information that
came with the device,

Witrox

What if I can't find the device pairing code?

[ MNext ][ Cancel l

Enter a 0 (zero) in the pairing field, then click Next. The WITROX driver will now be installed.

X5

&) ¥ Add a device

This device has been successfully added to this computer

Windows is now checking for drivers and will install them if
necessary, You may need to wait for this to finish before your device
is ready to use,

To verify if this device finished installing properly, lock for it in
Devices and Printers.

Witrox

The instrument is now ready to be used in AutoResp™.
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Right click on the device and choose Properties. Check the assigned COM port humber. This
COM port number must correspond to the COM port humber set in AutoResp™.

"7 Standard Serial over Bluetooth

Device Function Summary

Manufacturer:  Microsoft

Location: on Bluetooth Device (RFCOMM Protocal TDI) #2
Device status:  This device is working propery

Connect a fiber optic sensor to the front input (marked CH1-CH4). Connect the Pt1000
temperature sensor to the front input marked TEMP.

For more information on fiber optic sensors, see page 13.
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4.2DAQ-BT

STATUS

DAQ-BT

The DAQ-BT instrument is used for wireless data acquisition and automated control of Loligo®
swim tunnels in combination with AutoResp™ software. The wireless Bluetooth communication
means that the PC can be placed at a distance from the swim tunnel without data cables that
can pick up noise in a lab environment.

Apart from the inputs and outputs needed for controlling the swim tunnel motor (RPM) and
acquiring data from it, the DAQ-BT instrument has extra channels for analog data acquisition
and TLL control of other devices.

SETUP

Connect the DAQ-BT instrument to the power adapter by using the USB cable on the backside
of the instrument.

Connect the power adapter to a wall outlet.

Push and hold the Power button for at least 5 seconds until the Power and Status LED flashes
green. The pairing mode for the DAQ-BT is now enabled.

Press the Windows Start button and choose Devices. An overview of the connected devices is
listed.
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oo e |

~ [ 43 ||| Search Devices and Printers

v|é » Control Panel » Hardware and Sound » Devices and Printers »
Add a device Add a printer

= -

4 Devices

Dell 2007FP USB Mess
(Analog) Storage Device

Generic
Bluetooth Radio

USB Receiver

4 Printers and Faxes

PR

Please click on the “Add a device” button.

Q M Add a device

P

Select a device to add to this computer

Windows will continue to look for new devices and display them here.

BTH-1208L5-5FA4
Bluetooth
Other

GT-N8000
Bluetooth
Phone

Bluetooth
Other

3 3

Bluetooth LE Device

What if Windows doesn't find my device?

Next | | Cancel

Click on the BTH-1208LS instrument, then click Next.
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@ [ Add a device

Select a pairing option

< Create a pairing code for me —
The device has a keypad.
9 Enter the device's pairing code BTH-1208L5-5FA4

The device comes with a pairing code.
Check for one on the device or in the device manual.

= Pair without using a code
This type of device, such as a mouse, does not require a
secure connection.

How can I tell if my device has a pairing code?

ven ) ()

L -

Please choose “Enter the device s pairing code”, then click Next.

“\

@ [I* Add a device

Enter the pairing code for the device

This will verify that you are connecting to the correct device.

0000

The code is either displayed on your device or in the information that
came with the device.

BTH-1208L5-5FA4

What if I can't find the device pairing code?

[ Next ][ Canr.ei}

. 4

Enter 0000 (four zeros) in the pairing field, then click Next. The DAQ-BT driver will now be
installed.
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) I Add a device

This device has been successfully added to this computer

Windows is now checking for drivers and will install them if
necessary. You may need to wait for this to finish before your device
is ready to use.

To verify if this device finished installing properly, look for it in
Devices and Printers.

BTH-1208LS-5FA4

Press the Windows Start button and open InstaCal from all programs/Measurement
Computing. InstaCal will detect the DAQ-BT and configure it properly.

-
. InstaCal = |8 EY

File Install Calibrate Test Help

OK [1]4

Plug-and Play Board m -.

The following plug and play devices have
been detected...

BTH-1208LS (serialt 1B85FA4)

Check those devices you wish to hawve
added to the configuration file.

Ready

The instrument is now ready to be used in AutoResp™. The assigned board number must
correspond to the board number set in AutoResp™.
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.[nsiaCaI = |6 =
File Install Calibrate Test Help | B Instruments
Eﬂ a @ @ [l [ ~=;:m % =m U Data aquisition instrument ~ Device name
E PC Board List DAQ—M VI %Edﬂl LI]
SR o Fiber optic instrument N1 COM port
-0 b TH-1208LS (serisl 1B85FAL) i v ¥
I Fiber optic instrument N*3  COM port
-none- Vl % L"
TEMP-4 instrument N° 1 Board number
NO vl ~|

Swim tunnel N° 1 instrumerft Board number
) DAQ-BT v/ Board0 |
Ready

To turn the instrument OFF push and hold the power buttons until both LEDs are turned OFF.

To turn the instrument ON without enabling the pairing mode push and hold the power button
for approximately 3 seconds until the power LED turns ON.

When the instrument is communicating with the software the status LED will start flashing.

To measure a Loligo swim tunnel connect a data cable from a swim tunnel controllers output
labeled OUT to the DAQ-BT instruments input labeled IN.

To control a Loligo swim tunnel connect a data cable from the DAQ-BT instruments output
labeled OUT to a swim tunnel controllers input labeled IN.

(5VvDC)
POWER
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4.3Bluetooth power strip (NETIO)

The Bluetooth power strip (NETIO) is essentially a 4-fold power strip for wireless software
control of equipment connected to one of the four independent electrical sockets, i.e., turning
pumps, valves, stirrers etc. on and off from a distance.

SETUP

Connect the Bluetooth power strip to a wall outlet. Turn ON the power strip with the power
button. When the power strip is ready for use the Bluetooth LED will light blue.

Connect the USB Bluetooth dongle to the PC. After the dongle has been found a COM port will
be assigned. Please open the device manager and check the COM port. This COM port number
must correspond to the COM port number set in AutoResp™.
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rﬂ Device Manager A @ﬁﬁ

File Action View Help
e @ E HE & ESS

4 g5, ERIK-PC
-6} Bluetooth Radios
&M Computer
[» = Disk drives
.p E Display adapters
& 4 DVD/CD-ROM drives
b é Floppy drive controllers
.p ﬂa Human Interface Devices
» g IDE ATA/ATAPI controllers
.D & Keyboards
b B Mice and other pointing devices
[ ! Monitors
[ E MNetwork adapters
475 Ports (COM &L LPT)
5" Bluegiga Blustooth Low Enflrgy (COM2) |
? Communications Port (COI
? Standard Serial over Bluetooth link (COMT)

. ? Standard Serial over Bluetooth link (COMBS)
b . Processors

E @ Security Devices

3 ﬂ Sound, video and game controllers

&> g8 System devices

.p i Universal Serial Bus controllers

The Bluetooth power strip is now ready for use in AutoResp™.
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4.4DAQ-M

The DAQ-M instrument for USB is used with AutoResp™ software for automated oxygen
consumption measurements in up to eight static chambers or two swim tunnels, and for
monitoring and regulating ambient water temperature and oxygen saturation.

SETUP

To power up the instrument connect the power cord to a grounded wall outlet and the socket
labeled 100-240 VAC 50-60Hz on the back side of the instrument. Remember to switch the
instrument ON/OFF using the main power switch. Connect the USB cable to the front input
(marked PC) and to a free USB port on your PC.

First time the DAQ-M instrument is connected to the PC, the drivers will be installed. This
might take some time.

All analog outputs from oxygen and temperature instruments, and swim tunnel motors, must
be connected to input channels 1-8 on the DAQ-M instrument using either single or split
(double) data cables supplied with the devices.

The digital relays are used to control pumps for flushing/recirculating and pumps or valves for
ambient water quality control. See page 56.

SPECIFICATIONS

Supply voltage:
PC interface:
Input channels:
Input voltage:
Output channels:
Ouput voltage:
Resolution:
Signal noise:
Frequency:
Relays:

Relay voltage:

Relay max. power:

100-240 VAC, 50-60 Hz
USB 2.0 (1.1 compatible)

8

0-10V

2

0-10V

14 bit (single-ended)
62 dB

1000 Hz

4

100-240VAC, 50-60 Hz
2 A per channel (max 6.3 A for all relays)
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4.5 TEMP-4

The TEMP-4 is a four channel instrument for monitoring, recording and controlling water
temperature with AutoResp™ or TempCTRL software.

SETUP

To power up the instrument connect the power cord to a grounded wall outlet and the socket
labeled 100-240 VAC 50-60Hz on the back side of the instrument. Connect Pt100 temperature
probe(s) to the front inputs (marked IN 1 - IN 4). Then connect the USB cable to the front
input (marked PC) and to a free USB port on your PC.

SPECIFICATIONS

Supply voltage: 100-240 VAC, 50-60 Hz

PC interface: USB 2.0 (1.1 compatible)

Inputs: 4

Resolution: 24 bit

Signal noise: 60 dB

Frequency: 16 Hz

Relays 4

Relay voltage: : 100-240VAC, 50-60 Hz

Max. relay current: 2 A per channel, 6,3 A all channels

Page 25 of 74
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First time the TEMP-4 instrument is connected to the PC, the drivers will be installed. This
might take some seconds. Then open InstaCal (this software is installed together with

AutoResp™) and check the assigned board number. This board number must correspond to the
board number set in AutoResp™.

'lnstaCaI b —
File Install Calibrate Test Help

ox | ox 1
EEe B sy A A8
A PC Board List
(=003 Universal Serial Bus

L u Board# 1 - USB-TEMP (serial# 97)

E!“‘;’F’? : L
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5.SENSORS

5.1Flow-through cell mini sensor

The flow-through oxygen mini sensor is for use with 10 - 13 mm tubing, and requires a fiber
cable with bare tip for use with Witrox 1 or Witrox 4 instruments. The re-usable (non-
disposable) oxygen sensor has excellent long-term stability. Clean it with ethanol or even ETO,
recalibrate, and use it again and again.

Features:

Easy to handle

Very robust sensor

Excellent long-term stability

No self-consumption of oxygen

Signal independent on flow velocity

Insensible towards electrical interferences
Measures oxygen in liquids as well as in gas phase
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5.2Dipping probe mini sensor

The dipping probe oxygen mini sensor, consists of a polymer optical fiber (POF) with a polished
distal tip which is coated with a planar oxygen-sensitive foil. The end of the polymer optical
fiber is covered with a high-grade steel tube, to protect both the sensor material and the POF.
The cable has an outer diameter of 2.8 mm. The inner diameter of the POF is 2.0 mm. The
steel tube has an outer diameter of 4 mm. Usually, the fiber is coated with an optical isolated
sensor material in order to exclude ambient light from the fiber tip and to increase chemical
resistance especially against oily samples as well as to reduce bio-fouling on the sensor
membrane. This type of oxygen sensor has an excellent long-term stability.

Features:

Easy to handle

Usable for process application

Limit of detection: 0.15 % air-saturation, 15 ppb dissolved oxygen
Measuring range: 0 - 100 % oxygen, 0 - 45 mg/L

Very robust sensor with excellent long-term stability
Sterilizable by H202, ethanol, gamma irradiation, EtO2

No self-consumption of oxygen

Signal independent on flow velocity

Insensible towards electrical interference and magnetic fields
Dry gases applicable

Robust sensor body
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5.3Sensor spot mini sensor

—
e

Sensor spots are thin planar oxygen mini sensors immobilized onto either polyester or glass
supports. The latter is autoclavable. The sensor spots are glued inside chambers, flasks or
disposables with translucent and non-fluorescent walls (e.g. glass, polyester, acrylic etc.).
Then oxygen measurements can be done in a non-invasive and non-destructive way from
outside and through the wall of your vessel.

Features:

Excelent long-term stability

Easy to handle and robust

Non-invasive and non-destructive measurement from outside through the wall of the flask
Usable for process application

No self-consumption of oxygen

Signal independent on flow velocity

Insensible towards electrical interferences and magnetic fields
Measures oxygen in liquids as well as in gas phase

Excellent mechanical stability and long-term stability

Online monitoring
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5.4Temperature sensor Pt1000

The Pt1000 temperature probe is robustly constructed with a stainless steel protection sheath,
moulded mini handle with built in stress relief and complete with 5 metre of cable and
connector for our Witrox instruments.

The Pt1000 sensor has a tolerance of 1/3 of Class B sensor giving a very high accuracy of +/-
0.15°C.
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6.SOFTWARE INSTALLATION

6.1 AutoResp™ installation

The following steps will explain how to install AutoResp™ and instrument drivers on your PC.

Minimum PC requirements:

CPU Duo core 2,4 GHz or similar
RAM 4 GB

USB ports 2-5 (system dependent)
Monitor 1024 x 768

It is important to remove any previous versions of AutoResp™ before starting to install new
AutoResp™ software:

1. Click Start->Control Panel
2. Open Programs and Features
3. Double click on National Instruments software

4. Select all packages, and then click on Remove.

-
.B National Instruments Software ==

Products - x| Modify

NS Sotware 135 (Y| oottt e mned ot
NI CompactRIO 3.5.0 i features.
NI CompactRI0 Medule Support 3.5.0
NI FlexRIQ 1.5.0
NI FlexRIO Adapter Module Support 1.5 Reinstall missing or comupt files, registry keys, and shortcuts.
NI Hierarchical Waveform Storage 1.4.8 4 Preferences stored in the registry may be reset to defautt
NI IVI Compliance Package 4.2 values.
NI Instrumnent I/O Assistant
NI LabVIEW 2009 Remove

NI LabVIEW 2010 Remove product from this computer.

Repair

5. You will then be notified that AutoResp™ also will be removed. Click Yes
6. Now wait until all packages are uninstalled. This might take some time.
7. Windows will now ask for a restart.

8. When the computer is restarted, please proceed and install the new AutoResp™
software.
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Insert the USB memory stick labelled Loligo and wait until you see the following screen.

F

-
< AutoPlay El_‘ﬂ

~ Removable Disk (E:)
-

General options

Open folder to view files
J using Windows Explorer

View more AutoPlay options in Control Panel

Click Open folder to view files and double click on the icon labelled AutoResp_Installer.exe.

p

WinZip Self-Extractor - AutoResp_Installer.exe

A uto-::: Unzipping AutoResp™ by Loligo Systems Betun
Resp =

- Unzipping WC2

After the file has been unzipped, the Welcome screen will appear.

r = 3
4 AutoResp = | B |

Welcome to the AutoResp installer

Fleaze follow the ingtructions on screen. Do not turn off the computer until the
installation iz complete. 4

i

After the installation of AutoR esp the Loligo Service Pack 2 will be installed. |

Please wait whils the installer initislizes.

Lancel
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U7 AutoResp =HEER X

Destination Directory
Select the primary installation directory.

Al zoftware will be inztalled in the following location(z]. Ta install zoftware into a
different location(z], click the Browse button and select another directory.

Diirectary for AutaResp

|C:'\Progmm Files\AutoResp™ | I Brovese... ]

Diirectary for Mational Instrurments products

|C:"\Progmm Files\National Instruments™, | I Erowese... I

<< Back “ Nestss I Cancel

Select destination directory for AutoResp™ and for the drivers and click Next.

[ U3 AutoResp == ] |
-__________________________________]

License Agreement
'ou must accept the licenzel(z] displaved below to procesd.

NATIONAL INSTRUMENTS SOFTWARE LICENSE AGREEMENT ~

INSTALLATION NOTICE: THIS IS A CONTRACT. BEFORE YOU DOWNLOAD THE SOFTWARE
ANDIOR COMPLETE THE INSTALLATION PROCESS, CAREFULLY READ THIS AGREEMENT. BY
DOWNLOADING THE SOFTWARE AND/OR CLICKING THE APPLICABLE BUTTON TO
COMPLETE THE INSTALLATION PROCESS, YOU CONSEMNT TO THE TERMS OF THIS
AGREEMENT AND YOU AGREE TO BE BOUND BY THIS AGREEMENT. IF YOU DO NOT WISH TO
BECOME A PARTY TO THIS AGREEMENT AND BE BOUND BY ALL OF ITS TERMS AMD
CONDITIONS, CLICK THE APPROFRIATE BUTTOM TO CANCEL THE INSTALLATION PROCESS,
DO NOT INSTALL OR USE THE SOFTWARE, AND RETURN THE SOFTWARE WITHIN THIRTY
(30) DAY'S OF RECEIPT OF THE SOFTWARE (WITH ALL ACCOMPANYING WRITTEN MATERIALS,
ALOMNG WITH THEIR COMTAINERS) TO THE PLACE YOU OBTAINED THEM. ALL RETURMS
SHALL BE SUBJECT TO NI'S THEN CURRENT RETURN POLICY.

@ 1| accept the License Agreement §

7 | do not accept the License Aagreement.

<¢ Back ][ Mest »» ] I Lancel

If you accept the License Agreement, please select "I accept the License Agreement. Then click
Next.
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License Agreement
ou must accept the licenselz) displaved below to procesd.

NET 2.00 v

MICROSOFT SOFTWARE SUPPLEMENTAL LICENSE TERMS
MICROSOFT .NET FRAMEWORK 2.0

Microsoft Corporation (or based on where you live, one of its affiliates) licenses this supplement
to you. If you are licensed to use Microsoft Windows operating system software (the “software”),
you may use this supplement. You may not use it if you do not have a license for the software.
You may use a copy of this supplement with each validly licensed copy of the software.

The following license terms describe additional use terms for this supplement. These terms
and the license terms for the software apply to your use of this supplement. Ifthere is a conflict,
these supplemental license terms apply.

By using this supplement, you acceptthese terms. If you do not acceptthem, do not use this
supplement. If you comply with these license terms, vou have the rights below.

@i accept the above 2 Licenze Agreements)

(70 | do ot aceept all these License Agreement(s).

<< Back ][ Mext > ] I LCancel

If you accept the License Agreement, please select "I accept the License Agreement(s). Then
click Next.

r B

U3 AutoResp =SHACH X
S
Start Installation

Rewviews the following summary before continuing.

Adding or Changing
» M1 Spatem Configuration 1.1.1
» AutoResp Files
» MI-DAGm: 9.2.1
s M| KA Configuration Suppert
» MIYISA B0
Fiun Time Support
» LabVIEW C Interface
o M| Meazurement & Automation Explorer 4.7.1

Click the Mest button to begin installation. Click the Back button to change the ingtallation settings.

SaveFile... ] [ <¢ Back ][ Mest > ] I Lancel

A summary is given of the products to be installed. Click Next.
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-
U7 AutoResp =

Owerall Progress: 1% Complete

Fublizhing product infarmation...

The installation may take a while.

U AutoResp =

Installation Complete

The installer has finished updating your system.

When installation is complete click Next.
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[ Loligo SP2 I_ __?i ==

Readme
Fle. owing Infarmation.

[ \welcame to the Loliga Service Pack 2 installer.

| The following products will now be inztalled:

|- WiBuk.ey
-MCC Dag

Wielcome to the Wibuk.ey Software Setup program. Thiz
program will inztall Wibukey Software on pour computer.

[t iz gtrongly recommended that you exit all Windows programs [and the
control panel] before running this Setup program.

Click =Cancels to quit Setup and then cloge any programs pou have
TLINEIFIg.
Click, zMests to continue with the Setup program.

Yerzion B.00a

Cancel |

Click Next.
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48l WibuKey Setup

Pleaze select the languages that ‘wibuk.ey should support;

¥ Englizh

™ French

[ Gemman
[ ltalian

™ Hungarian
[T Japanese
[T Portuguese
[T Spanizh

¢ Back | MNewt > I Cancel

Click Next.

Select the wibuk.ey components wou like to install

v SR et AVELAN Network Server

[T Install 3z MT service with auboztart
[T whkNet Network Server for Movell Metware
v il LAM AadlM et b etwark Manitar [32 bit)
[T wikbet Hetwaork bMaoritar (16 bit]
[T &dditional Wibukiey Tools

Once pou have selected the components vou wizh to inztall,
preszs the sMests button to complete the installation.

Click Next.

¢ Back | Mest = I Cancel
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ﬂ WibuKey Setup

[f you press =Mests the following tazks will be performed:

Operating system: Windows Vista -
Source path: C:A\Uzers\LOLIGO 1 MAppD atatLocalh TemphWZSE

Selected languages:
Eniglizh

The following components will be inztalled:
Wwibuk.ep driver files

Wwibuk.ey COM control

WIBU-SYSTEMS Shell Extenszion
Wafibubk.ey network, server

fibuk.en tools

< Back |

Cancel |

Click Next.

ﬂ Wibukey Setup

[f you press wMests the following tasks will be performed:

The fallawing compaonents will be installed:
fibuk.en driver files

Wibuk.ey COM control

WBL-SYSTEMS Shell Extension =
Wwibuk.ep netwark server
Wafibuk.ey tools

Copying files ... done.

Werifying language modules ... done.
Inztalling files ... done.

Werifying inztalled language modules ... done,
Storing uninstall information ... done.
Creating shortcuts ... done.

Tranzfering settings ... done.

4

¢ Back |

Cancel |

Click Next.
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48 WibuKey Setup ==

Wwibuk.ey Software Setup iz complete.

Setup can launch the Readme help file with the latest product
infarmations.

[ ¥es. | want to view the Readme text now

Click =Finizhs to complete Setup.

Click Finish.
-Setup u
@ WibuKey driver successfully installed.
Click OK.

WinZip Self-Extractor [ B

Press OK to continue with installation.
E QK i ’ Annuller
Click OK.
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WinZip Self-Extractor - mccdag.exe

ﬁ Instaling MCC Dag Software.

Click Setup to start installing third party (Measurement Computing) device drivers.

ma MCC DAQ [ S|

V. U e MEASUREMENT /4
- AWK P COMPUTING !

Select the packages you want ta inztall or modify on vour computer.

d

T i - Description
F‘ m it hiversal Libtary [Crata logger, oscilloscope,
b acerDAl and strip chart recorder
- application.

Requirements:

------ : Hardware Manuals Windows 2000(SP4)XP(SP2)
Nistaly, I
Required dependencies: InstaCal for Windows, h
7 - Microsoft MET framework
------ [[1€3 Direct< 3.0c version 2.0, Direct¥ 9.0c
[nztall Yiew Feadie Cancel
= =—— == .

Deselect TracerDAQ, then click Install.
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‘ﬁ' InstaCal and Universal Library for Windows - InstallShield Wizard ﬁ

Welcome to the InstallShield Wizard for
| InstaCal and Universal Library for Windows

The Installshield(R) Wizard will allow you to modify, repair, or
remove InstaCal and Universal Library for Windows, To
continue, dick Next,

Wa N #a
AV b

MEASUREMENT
COMPUTING
« Back :[ Mext = ‘,i [ Cancel ]
Click Next.
- .
5] InstaCal and Universal Library for Windows - InstallShield Wizard =)
Program Maintenance & MEASUREMENT
.. AW\ b COMPLTING
Modify, repair, or remove the program.
Change which program features are installed. This option displays the
Custom Selection dialog in which you can change the way features are
installed.
Repair installation errors in the program. This option fixes missing or
corrupt files, shortcuts, and registry entries.
Remaove InstaCal and Universal Library for Windows from your
computer.
InstallShield
< Back " Mext = j [ Cancel ]
Click Next.
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5] InstaCal and Universal Library for Windows - InstallShield Wizard [

InstaCal and Universal Library for Windows r ‘ a MEASUREMENT
AV S COMPUTING

Select the program features you want installed.

Click an an icon in the list below to change how a feature is installed.

Feature Description
Universal Library Examples

[ Universal Library Examples

Visual Basic examples for Windows
Delphi examples for Windows
VB.MET examples far Windows
C# examples for Windows This feature requires OKB on
your hard drive. Ithas 0 of 5
subfeatures selected, The
subfeatures require OKB on yaour
hard drive.

o Wsers'\Public\DocumentsMeasurement Computing\DAQY

InstallShield

Help [ « Back ][ Mext = j [ Cancel ]

5 InstaCal and Universal Library for Windows - InstallShield Wizard [

R to Medify the P & MEASUREMENT
i e S AV bs COMPLITING

The wizard is ready to begin installation,

Click Install to beqin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

Installshield

< Back. ][ Install _] [ Cancel
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‘ﬁ' InstaCal and Universal Library for Windows - InstallShield Wizard u

Installshield Wizard Completed

The Installshield Wizard has successfully installed InstaCal and
Universal Library for Windows. Click Finish to exit the wizard.

Va N #a
AV b

MEASUREMENT
COMPUTING
< Sau:k _' Finish ~ Cancel
Click Finish.
[ Loligo sP2 [

Finished

ted. Do pou want to

Ty COMPUEEr now

i Mo, | will restart it later

ish to end the

<geck | [_Fish ] Conce

Choose “Yes, I want to restart my computer now”, then click Finish. After the PC has restarted
you have installed all AutoResp™ software and device drivers.
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6.2 WiBu software protection

AutoResp™ is protected with an USB hardkey dongle (WiBu), and will only run if a valid dongle
is connected to an USB port on the computer. If not, the error message below will appear.

AutoResp.exe: Start Error Iél

Retry Cancel

L

Plug in the WiBu hardkey dongle and wait to let it be recognized by Windows. Only then can
AutoResp™ be used.
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/. USE AUTORESP™

NB! To enjoy all functions in AutoResp™ it is necessary that the PC user has administrator
status. (page 71)

Start AutoResp™ from the start menu in Windows. It might take a few seconds to load the
program initially. Watch the Windows task bar.

AutoResp™ will start in the screen mode shown below. Here you can connect the different
instruments that you have, and configure the input channels on your DAQ instrument. Here
you also choose units of measure.

If one of our a DAQ-PACs or systems are used, please use the Auto configure function for a
quick setup.

E E E
E E E

NB! In AutoResp™ users can freely choose between the oxygen units % air saturation, kPa
(partial pressure of oxygen) and mgO2/L (oxygen concentration), but this requires a user input
for barometric pressure and salinity. Temperature is also required, but can be acquired
automatically if connecting a temperature instrument to the system.

1.  The digital output from the oxygen instrument must be calibrated in the AutoResp™
software to show correct oxygen values.

2. Measure at 0% air saturation, and press LOCK LO. Since fiber optic oxygen sensors are
sensitive to temperature, it is also necessary to enter this value.

3. Measure at 100% air saturation, and press LOCK HI. Since fiber optic oxygen sensors are
sensitive to temperature, it is also necessary to enter this value.

4. Choose Online (Ambient) as temperature input channel. It is very important to
temperature compensate the fiber optic oxygen values, since the oxygen values are very
temperature dependent.

5. Repeat this step for every oxygen channel.

6. The calibration and configuration is continuously saved to a binary file (AutoResp.conf).

7. Now choose Experiment->Start to start a respirometry experiment.
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Before the experiment starts a number of parameters must be given in order for
AutoResp™ to calculate oxygen consumption rate etc.

First enter the chamber volume and choose the correct unit.

Enter the volume of tubes in the recirculating loop only and choose the correct unit of
measure. In swim tunnels this tube volume should be set to zero (0).

Enter the wet weight of the animal(s) and choose the unit of measure.

Then enter the density of the animal(s) for the software to calculate the respirometric
volume.

The respirometric volume is calculated as:
Resp. voume [L] = chamber volume + tube volume - volume of organism(s)

The ratio field indicates the ratio between the Resp. volume and the wet weight volume.
As rules of thumb, this ratio should be 10-20 for measurements in resting animals, 10-50
for micro respirometry (<<50 mL) and up to 200 for measurements in active animals
(swim tunnel respirometry) for reliable MO2 measurements. If experimental
temperatures are high the ratio can be higher without compromising the quality of MO”
data.

NB! The solid blocking correction fields are only available when running with a swim tunnel,
see SWIM TUNNEL RESPIROMETRY, page 52.
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15. Now enter correct values for chamber 2.

16. When done, press OK.

17. Now a file dialog pops up, where the user is asked a file path for the (calculated) data file
and raw data file. The raw data file will get the same name as the data file but with

A\

_raw” as an extension to the file name.

110+
100

Oxygen [%air saturation]

Time

m AutoResp™ Flushed for 138 seconds |L|éj
File Experiment Settings Help
Flush © Close Intermittent Skip phase Add file note JREL@REZQ@ REZ @ RE4

|
14:07:14

Data | Moz I RA2 | MO2 histogram | MO2ws. 02 | MO2vs.temp | Ambient oxygen | Ambient temp

Slope

0

RA2

0
Uspeed
NaM
Uswim

Nah

Slope
0
R*2

Slope
o
R*2

Chamber 1 Chamber 2 Chamber 3 Chamber 4 Chamber 5 Chamber 6 Chamber 7 Chamber 8 Ambient #1
Oxygen Oxygen Crygen Oxygen Oxygen Oxygen Oxygen Oxygen Oxygen
EXE [psia | 914 | [s.76 | NalN Nal Mal NaN 99,92

Mo2 Mo2 Moz Moz2 mMo2 Mo2 Mo2 Mo2 Temperature
o | o | o | [o | 0 [ o 0 20,05

Slope
0
R*2

Ambient #2
Oxygen
Mall

Temperature
MNak

18. Now an experiment is started, but in a continous flush mode so that no oxygen

consumption measurements will take place until the user sets the operation to either
“Close” (closed respirometry) or Intermittent (intermittent respirometry).

19. Move the mouse over the relay indicator diodes in the upper right corner. A Help text will
pop up and help the user which relay is used as recirc, flush, ambient control etc.

20. The upper screen shows the oxygen values for the chambers. Right clicking on the graph
will show a submenu. It is here possible to hide/show chamber graphs, pause graphs,

scale axes etc.

NB! Please note, that AutoResp™ will continue collecting data even though graphs are set on
pause (Show cursor). While set on pause the x-scrollbar appears and it is possible to go back
to the start time of the experiment using the scrollbar.
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NB! If using the cursor and having troubles that others graphs values are shown, use the
sticky function. The sticky function will attach a cursor to the curve from one chamber
specified by the user.

21,

22.

23.

24,

The lower graph panel shows the data and graphs for calculated values.

The Data tab will show all current values. Some fields are gray, depending on the
configuration mode. So in the current example case, chamber 1 and 2 are shown and the
ambient temperature only.

Because the ambient temperature was activated, an ambient Temp tab is also
accessable, showing ambient water temperature in real time or average values over time
(right click). Depending on the configuration, different tabs may appear, such as ambient
oxygen, Uspeed (swimming speed) etc.

In the upper right corner, the kind of experiment currently running can be chosen.

Flush - This means that the flush is always on. The object will get fresh water constantly,
but this also means that no MO2 values are calculated.

Close - This means the chamber is closed, and every time a measure period is finished a
MO2 is calculated. After the measure period is finished a new measure period will begin
immediately. If choosing this mode of operation, take care not to leave the set up to
avoid severe oxygen depletion inside the chamber due to animal respiration.

NB! The object will remove all oxygen from the chamber after some time, and then the object
will DIE! Use with care.

25,

Intermittent — This means the experiment runs in a loop (flush, wait and measure) as
explained in the back ground theory chapter (page 62). During each flush period, the
flush pump is turned on to flush chambers with ambient water. The wait periods allow
time for steady state before measurements start during the measure period.

In Intermittent mode, the skip phase button allow users to jump between these three
modes (flush, wait measure) immediately and on-the-fly for special applications or
situations, e.g. to start flushing the chamber immediately after reaching Ucrit during a
swim trial.

LOOP

FI>W1->M1>F2>W2->M?2 etc.

For more information about the Intermittent principle, see page 63.

Now choose Settings>General to set the settings for the experiment.
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rm General settings [i:?-Jw

Oxygen
Unit (graphs) Salinity [%aa] BP [hPa]

Sair saturation | [ | $hoz0 |

Intermittent respirometry
Flush [s]

I
Wait [s]

I
Meazure [z]

sheo |

Recirc pump always OMN

MO?2 analysis

SMR estiration Min 02 [%a.s.] piCrit estimation [N]

median, all - : ] : 10

| OK | | Cancel |

In the General settings it is possible to change oxygen units, water salinity or barometric
pressure during experiments. It is also possible to change flush, wait and measure times.

Flush times should be set to allow complete renewal of water inside each chamber. This
will restore oxygen values to ambient between each measurement. As a rule of thumb,
cylindrical chambers should be flushed with a volume five times the chamber volume for
99% wash-out, but this depends on chamber dimensions.

The measurement times should allow enough data for a reliable determination of the
slope of the oxygen curve to be estimated. The slope is determined from a linear
regression, and the regression coefficient r~2 express the statistical validity of the
calculated slope, e.g. r*2 >0.95 indicates a sound linear relationship (oxygen vs. time),
and thus a reliable MO2 value.

Notice that the recirculating pump can be set to constant activity. This will double the
flow during flush periods potentially affecting animal behavior/locomotion, but will
provide better oxygen readings if the oxygen probe is placed outside the chamber in a
recirculating loop.

The MO2 analysis buttons are gray during measurements, but can be used during post
analysis when loading saved raw data files form past experiments.

Press OK to close the general settings.
Now run an experiment for min/hours/days depending on application. Adjust your

settings during measurements if needed. Any changes will be written in the raw and data
file.
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B AutoResp™ o=
File Settings  Help
Flush Close Intermittent Skip phase Add file note JREL@RE2 @ REZ @ RES

B AV NN AN AN

Oxygen [%air saturation]

80

| |
04:37:42 08:37:42

Time

< 1 b

Moz | R"2 | MO2histogram | MO2vs. 02 | MO2vs.temp | Stats |

MO2 [mg02/kg/hr]

20-) D | D | D | D | D | D | D | | | D | D | i
12:05:44 13:00:00 14:00:00 15:00:00 16:00:00 17:00:00 18:00:00 19:00:00 20:00:00 21:00:00 22:00:00 23:00:00 00:00:00 01:00:00 02:00:00 03:00:00 04:00:00 05:00:00 06:00:00 07:00:00 08:00:00 0%:11:09
Time

Your graph should look like this. This is a graph for one chamber only.
30. To end the experiment, click Experiment->Stop.
31. Now press File>Load to analyze saved data. The file loading might take a while.

32. When the file is loaded, a new tab labeled Stats are now available for the user. Use this
tab for calculations and statistics.
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B AutoResp™ [
File Settings  Help
Flush Close Intermittent  Addfilenote JRELG@REZ@ REZ @ RE4
ol
92,5
E k\f\‘rﬁ\'ﬂ/\i’ h\hﬁfﬁ\u‘h\f\\r\/\r\‘iﬁ\ﬁ)\‘{ | }\(\'f\‘m‘r‘\ﬁ\f}\'\f}\lﬁ\' \J\Nl ‘\(\\f)\\f\ '\f\r\"(\1’\1'h‘\h\{\ )\fj\'-,l')\\f \llh\f}\\f\\

80- ]
08:37:42

|
04:37:42
Time
« 13
MO2 | R*2 | MO2 histogram | MO2vs.02 | MO2vs temp ~Stats |
Chamber 1 Chamber 2 Chamber 3 Chamber 4 Chamber 5 Chamber 6 Chamber 7 Chamber 8
SMR SMR SMR SMR SMR SMR SMR SMR
[526014 | [58586 | 47,4222 42,68 NalN NaN NalN NaN
Perit Perit Perit Perit Perit Perit Perit Perit
[o1,5563 | [0s,5100 | 79,8971 59,4039 Nah Nah Nal Nah

33.

The analysis settings are available in Settings>General. Choose SMR estimation method

and choose a minimum average oxygen level for estimating standard metabolic rate
(SMR) to exclude any hypoxic values. For hypoxia experiments, the critical point for
metabolic homeostasis (Pcit) can be calculated automatically. Click the button to set the
number of low oxygen values that should be part of the oxy-conforme curve when the
animal is no longer able to regulate respiration rate independently of ambient water

oxygen.

pCrit calculation curve

use for SMR

MO2 [mg02/kg/hr]

[ 1 [ 1 [ i i i i i i 1 ! 1
4500 5000 5500 6000 6500 70,00 7500 80,00 8500 90,00 9500 100,00 10500 110,00

Average oxygen [%air saturation]

[
40,00

[
35,00

[ [
2500 30,00

i [ [
5,00 1000 1500 20,00
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8.SWIM TUNNEL RESPIROMETRY

If you purchased a Loligo™ swim tunnel respirometer to measure oxygen consumption in
swimming animals the AutoResp™ software has several features for real-time data acquisition,
analysis and control. The AutoResp™ is able to operate one or two swim tunnels at a time.

8.1 Motor output

In AutoResp™ it is possible to acquire an analog DC voltage signal or a tacho signal from a
Loligo™ swim tunnel motor controller. The tacho signal will give the more precise
measurement of water speed (RPM), so we recommend collecting this type of signal if possible.

8.2Motor input

In AutoResp™ it is possible to generate an analog DC voltage signal to control a Loligo™ swim
tunnel motor controller.

8.3 AutoResp™ settings

To set up AutoResp™ to collect a swim tunnel motor output signal, the motor must be running.
It is possible to measure oxygen consumption rates and swimming speed from up to two swim
tunnels simultaneously. Data from swim tunnel N°1 will appear as chamber 1 and data from
any second swim tunnel will be saved under chamber 5 in files, graphs etc.

Configure
Chamber1 Chamber 5
Chamber 2 Chamber &
Chamber 3 Chamber 7
Chamber 4 Chamber 8
Ambient ciygen N1 Ambient oxygen N 2
Arnbient ternperature N° 1 Ambient temperature N® 2
Swim tunnel Nf1 v Swim tunnel N® 2

If Swim tunnel N°1 is activated a tab labeled Velocity (CH 1) will appear. If Swim tunnel N°2 is
activated another tab labeled Velocity (CH 5) will be active.

AutoResp™ will also be asking if a DAQ-BT is used. If a DAQ-BT is used please enter the board
number. No further in or output settings are necessary then.

Click the tab to calibrate the swim tunnel motor output to show correct water and swim speeds
in the software.
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General Velocity (CH1)

Velocity input channel Input type Velocity control 10+
DAQ-M, channel 1 v| Voltage v| Disabled v|

Moving average Input [V] Velocity [em/s] Output [V]

No | [4,88 | [a,76 | 400,00

TWO-POINT CALIBRATION

Input [V] Velocity [em/s] Output [V]
| Llocklo | =000 | Fboo | oo
Input [V] Velocity [em/s] Output [V]
| LockH | Slo00 | §l000 | 4500 0-

1 1 1 1 1 1 1
13:44:15  13:44:35 13:44:35 134445 134455 134505 134515
Time

First click on the input channel and choose the input channel. Any of the eight input channels
on your DAQ-M instrument can be used. Then choose between a voltage type or tacho type of
signal from the motor. If choosing the tacho type of signal, it will take about 10 seconds before
the tacho signal starts in the graph.

If AutoResp™ has to control the motor, enable Velocity control. For Velocity (CH 1) the OUT 1
output is used, for Velocity (CH 5) OUT 2 is used. The output [V] can manually be set by
entering a value.

Now perform a 2-point calibration at two known velocities and Output [V] values for the
software to show correct velocity units (e.g. cm/sec).

E.g. set the LO value to 0,75 V, wait until the Input [V] value gets stable, then press Lock LO,
and enter the velocity in the Velocity [cm/s] field.

After the flow calibration, click start experiment. In the setup experiment screen it is now
possible to enter the fish length and to choose if solid blocking correction should be used.

m Setup experiment X
Chamber parameters

Chamber volume Tube volume Wet weight Density [kg/L] Resp.volume[L]  Ratio MNotes

Chamber1 3T L = %P [mL w| 0 |9 w| ik | ba | 9 \ |
Chamber volume Tube volume Wet weight Density [kg/L] Resp.veolume[L]  Ratic Notes

Chamber2 ;2 L vl o ml wl  Hawo |g w| 21 18 9 [ |
Chamber volume Tube volume Wet weight Density [kg/L] Resp.volume[L]  Ratio MNotes

Chamber3 ;2 L v %o mL w| %30 g w| 21 27 [ |
Chamber volume Tube volume Wet weight Density [kg/L] Resp.veolume[L]  Ratic Notes

Chamberd 2 L v % mlow| Y0 [g w| 4 6 9 \ |
Chamber volume Tube volume Wet weight Density [kg/L] Resp.volume[L]  Ratio MNotes

Chamber5 /1 L v %o ml w| 100 g w| 21 09 ] [ |
Chamber volume Tube volume Wet weight Density [kg/L] Resp.veolume[L]  Ratic Notes

Chamber6 1 L w =) mL W +[100 g | 1 09 9 ‘ |
Chamber volume Tube volume Wet weight Density [kg/L] ~ Resp.volume[L] Ratio  Notes

Chamber7 /1 L v %o ml w| 100 g w| 21 09 ] [ |
Chamber volume Tube volume Wet weight Density [kg/L] Resp.veolume[L]  Ratic Notes

Chamber8 1 L w =) mL W +[100 g | 1 09 9 ‘ |

Solid blocking correction
Cross section area [cm2]  Fish length (cm) Fish width (cm) Fish depth (cm) Fractional error [%]
Swim tunnel 1 2o g 10 =] =10 MNaM
Cross section area [cm2] Fish length (cm) Fish width (em) Fish depth (cm)  Fractional error [36]
Swim tunnel 2 =] 210 =11 2o Nahl | oK | ‘ Cancel
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An animal swimming in a (closed) channel obstructs the flow of water, causing the water to
run faster past the swimming animal. This results in a fractional error, i.e., a difference in
water velocity depending on the size of the animals and the dimensions of the channel.

Formula (Bell & Terhune, 1970):

Fractional error = 0.8 ¢ 0.5 (Fish length/fish radius) e (fish square area/cross area)??

Fish length

Fish radius ("Thickness™)

Fish square area
Cross sectional area

: Body length of fish

: (fish width + fish depth)/4

: L e (fish radius)?
: cross area of swim tunnel working section

The fractional error is used to convert water velocity in cm/s (as measured during flow
calibration with no fish in the working section) into corrected relative swimming speed in BL/s
during experiments with swimming fish.

Reference

Bell, W.H. & Terhune, L.D.B. (1970). Water tunnel design for fisheries research.
Fish.Res.Bd.Can.Tech.Rep. 195, 1-69.

Oxygen [%air saturation]

Time

m AutoResp™ Flushed for 85 seconds |L|éj
File Experiment Settings Help
Flush © Close Intermittent Skip phase Add file note JREL@REZQ@ REZ @ RE4

1
14:16:09

Data | MO2 | R*2 | MO2 histogram | MO2vs.02 | MOZus.temp | MO2vs. Uwater | MO2vs Uswim | Uwster | Uswim |

Chamber 1
Oxygen

oz

Mo2

Chamber 2
Oxygen
Mall

M02

0

Slope

Chamber 3
Oxygen
NalN

MO2

o

Slope

0

R*2

Chamber 4
Oxygen
MNaM

M02

]

Slope

0

R#2

Chamber 5
Oxygen
NaM
o2

o
Slope

0

RA2

o
Uspeed
NaM
Uswim

Nah

Chamber 6
Oxygen
Nal

Mo2

0

Slope

0

R#2

Chamber 7
Oxygen
Mahl

Mo2

o

Slope

Chamber 8
Oxygen
Mal

M2

0

Slope

0

R*2

Ambient #1
Oxygen
Mall

Temperature
MNak

Ambient #2
Oxygen
Mall

Temperature
MNak
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Uwater: This graph plots uncorrected water velocity versus time. By right clicking
the graph it is possible to show average values for each measuring period
instead of real-time values.

Uswim: This graph plots swimming speed versus time. The unit of measure for
Uswim is body lengths per second (BL/s). When solid blocking correction is
activated, corrected swim speed in BL/s will be shown. By right clicking the
graph it is possible to show average values for each measuring period
instead of real-time values..

MO2 vs. Uwater: This graph plots the MO2 value for each measuring period against average
Uwater.

MO2 vs. Uswim:  This graph plots the MO2 value for each measuring period against average
Uswim.

To control the velocity enter the menu Settings->Velocity control.

E‘  Velocity control E

Enable the Velocity control, and enter the setpoint value. A ramp function allow users to let the
software change set points up or down (use negative step value). When activating the ramp
function AutoResp™ will automatically increase/decrease the setpoint by a given interval and
after a given time interval. The duration of the time interval can be set in minutes or in
number of loops, During a loop, set points are ramped (changed) at the onset of a flush
period.
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9.AMBIENT WATER QUALITY

Two relays are available for ambient water quality control ( e.g. temperature or oxygen), but if
using a TEMP-4 instrument also two extra relays will be available for temperature control only
(see table below).

Ambient/Instrument DAQ-M/NETIO TEMP-4
Oxygen #1 RE 3
Oxygen #2 RE 4
Temperature #1 RE 4 RE 1
Temperature #2 RE 3 RE 2

For further help on what instrument relays to use for the different devices, try to place the
mouse over any of the four LEDs in the upper right corner in AutoResp®. This will give you a
help text depending on the system configuration (see below).

B AutoResp™ Flushed for 6 seconds S e
File Experiment Settings Help
Flush @ Close Intermittent Skip phase Add file note JREL@RE. @ 3@ RES
[Ambient 02 N° 1
100,1-

=

=

®

=

B

3

&

5

§
69,4308 =] 7

12:19:41 12:24:41
Time
Data | Moz | R"2 | MO2 histogram | MO2vs. 02 | MOZ2vs.temp | Ambient oxygen | Ambienttemp . '

Chamber 1 Chamber 2 Chamber 3 Chamber 4 Chamber 5 Chamber 6 Chamber 7 Chamber 8 Ambient #1
Ouygen Oygen Owygen Owygen Oxygen Owygen Oxygen Ouygen Owygen
Nal Nal Nal Nal Nal Nal Nall Nal 99,51
Mo2 Moz Moz Moz Mo2 Moz MO2 Mo2 Temperature
o (i ] 0 o ] ] o 99,02
Slope Slope Slope Slope Slope Slope Slope Slope
o (i ] 0 o ] ] o
R"2 R*2 R"2 R"2 R*2 R"2 R*2 R"2
o 0 o 0 o 0 0 1] Ambient #2
Uspeed Uspeed Oxygen
MNal MNal 99,88
Uswim Uswim Temperature
Nal MNal 99,7
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9.10xygen saturation

To control the oxygen saturation in the ambient water used for flushing respirometer
chambers, a DO-SET is needed. This DO-SET can either be connected to the DAQ-M
instrument for software control and monitoring of ambient oxygen levels or an OXY-REG
instrument for standalone operation. The DO-SET includes:

e Solenoid valve
e Air stone
e Tubing

To use the DO-SET assemble the system shown in the figure below. The power cord is
connected to the DAQ-M or OXY-REG.

DAQ-M (RE 3/RE 4)
Solenoid valve

Fd /7\\
s Tubing
Power cord
02}

TN

#

Air stone

Water tank

For using a DO-SET with AutoResp™, connect the solenoid directly to one of the DAQ-M/NETIO
relays. Now activate ambient oxygen N°1 in the software (see below). After the calibration and
experiment settings is finished, the ambient oxygen control settings can be found under
Settings>0Oxygen control.
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Activate oxygen control to start controlling the ambient oxygen saturation. Now set the
setpoint and hysteresis and if the you want hypoxic (inject nitrogen gas) or hyperoxic (inject
clean oxygen gas) control. Hypoxic control will keep ambient oxygen saturation below
normoxic levels to a set point value choosen by the user and visa versa. This set point value
can be altered by the user at any point in time.

Graphic depiction of the relay function setpoint:

b Relay units A Relay units
100 + 100
o0} %01
80 I EIJ:
70 I ?l]:
&0l gl ___Hysteresis=10__________
ol eeeef Setooint=80 N TW Setpoint=50 ./l ...
40 I sef b EEEERESL ----—---————l 40:
30 I au:

20

10

-
0 10 20 20 40 50 &0 7O 80 90 100 0 10 20 30 40 S0 /O TO 80 90 100
Relay action: Increasing Relay action: Decreasing

A ramp function allow users to let the software change set points up or down (use negative
step value) in a step-wise way for both temperature or oxygen control. When activating the
ramp function AutoResp™ will automatically increase/decrease the setpoint by a given interval
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and after a given time interval. The duration of the time interval can be set in minutes or in
number of loops, e.g. change the set point for ambient oxygen by 10% air sat. after each third
measuring loop. During a loop, set points are ramped (changed) at the onset of a flush period.

The user can choose between ramping setpoints with or without feedback. Feedback means
that setpoints are not ramped (changed) until the measured value has reached the setpoint
value. This to avoid problems with large volumes of water and/or large steps of
increment/decrement in values, in which case it can take considerable time to change water
temperature or oxygen saturation.

Finally, the user can set minimum and maximum setpoint values to avoid severe changes or
harmfull conditions when using the automated ramp functions.

NB! Please note, if changing oxygen units, the ramp function settings should be adjusted
accordingly by the user.

9.2 Temperature

To control the temperature of the ambient water used for flushing and thermostating
respirometer chambers, a TMP-SET is needed. This TMP-SET can either be connected to the
DAQ-M instrument for software control and monitoring of ambient oxygen levels or an TMP-
REG instrument for stand alone operation. The TMP-SET includes:

e Stainless coil
e Pump
e Tubing

To use the TMP-SET, assemble the system as shown in the figure below. The power cord for
the pump is connected to a DAQ-M or TMP-REG relay using a power strip or adapter cable
supplied with the system.
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DAQ-M (RE 3/RE 4) or
TEMP-4 (RE 1/RE 2)

Tubing

Cooling/heating bath

Power cord

Vg Eheim pump

Water tank

For using a TMP-SET with AutoResp™, connect the pump to one of the DAQ-M/NETIO relays as
explained above. Now activate ambient temperature N°1 in the software (see below). After the
calibration and experiment settings is finished, the ambient temperature control settings can

be found under Settings>Temperature control.
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B

Activate temperature control to start controlling the ambient temperature. Now set the
setpoint and hysteresis and how the relay has to work. The control can either keep the
ambient temperature above the setpoint (Heat) or below the setpoint (Cool). If heating the
bath in which the stainless coil is submerged must be filled with heated water. If cooling the
bath must be filled with chilled water.

For help using the ramp function, see explanation under ambient oxygen control above.
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10. BACKGROUND THEORY

10.1 Measuring metabolic rate

Metabolic rate is one of the most important physiological variables for comparing performance
and adaptations of different organisms, and it is a measure of the total energy consumption
over time. However, it is only possible to measure the amount of energy consumed for
metabolism by one of four indirect methods:

1. Energy contents of food minus energy content of waste products
2. Oxygen consumed or CO:2 excreted (respirometry)
3. Heat production (calorimetry)

4. Metabolic water produced (isotopic techniques)

Of these oxygen consumption (MO2) is the easiest to measure in water, and MO is closely
linked to the heat production no matter what organic substrates are burned (in average 20 kJ
per litre O2).

Anaerobic metabolism cannot be determined through MO2 measurements, causing misleading
results in some organisms.

10.2 What is oxygen used for?

All organisms use energy at a rate that can be determined and expressed in different ways.
The energy is used for maintaining homeostasis, and for vital and energy consuming processes
like osmo regulation, acid-base balance, protein synthesis etc.

The metabolism of higher animal cells (eukaryotes) is primarily based on aerobic respiration
requiring oxygen in order to generate energy (ATP).

Simplified reaction:

CsH1206 (aq) + 602 (g) — 6CO2 (g) + 6H20 (1)

AG = -2880 kJ per mole of CeH1206

Oxygen is used in the reaction, thus measured oxygen consumption rate of an organism
mirrors the aerobic metabolism.

Oxygen molecules are used as the “terminal electron acceptor” in the respiratory chain during

oxidation of organic molecules. The product of this process is energy in the form of ATP
(Adenosine Triphosphate), by substrate-level phosphorylation, NADH and FADH?2.
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10.3 Intermittent respirometry

The measuring principle behind
AutoResp™ is so-called intermittent
respirometry, one of three widespread
methods for oxygen consumption

N
measurements (respirometry) in aquatic <
breathers: 2
X
l¢] I,
1. Closed respirometry (or constant
volume respirometry) Time
N7
=
o
. X X £
2. Flow-through respirometry (or open ! - &
respirometry)
N
g
3. Intermittent respirometry (or stop-flow X, g

respirometry)

Time

10.3.1. Closed respirometry

Measurements in a sealed chamber of known volume, ie. a closed respirometer. The oxygen
content of the water is measured initially (t0), then the respirometer is closed and at the end
of the experiment (t1) the oxygen content is measured again.

Knowing the body weight of the animal, the respirometer volume and the oxygen content of
the water at time t0 and t1 the mass specific oxygen consumption rate can be calculated as
follows:

|
Vo, = ([02 ]zo _[02 ]n)?ﬁ
VO2 = oxygen consumption rate (mg Oz/kg/hour)

[O2]to = oxygen concentration at time to (mg O2/liter)

[O:2]t: = oxygen concentration at time t: (mg O2/liter)
V = respirometer volume minus volume of experimental animal (liter)
t = t:1 - to (hour)
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BW = body weight of experimental animal (kg)

An advantage of this method is its simplicity. A disadvantage is that the measurements are
never made at a constant oxygen level, due to the continuous use of oxygen by the animal
inside the closed chamber. This might cause problems when interpreting data, since animal
respiration often changes with ambient oxygen partial pressure.

Furthermore, metabolites from the experimental animal (e.g. CO2) accumulate in the water,
thus limiting the duration of measurements. The limited time for measurements prevents the
experimental animal to recover from initial handling stress that often increase animal
respiration significantly and for several hours, thus overestimating oxygen consumption rates.

10.3.2. Flow-through respirometry

This is a more sophisticated method for oxygen consumption measurements. The experimental
animal is placed in a flow-through chamber, with a known flow rate. Oxygen content is
measured in both the inflowing and outflowing water, and oxygen consumption rate can then
be calculated as:

Vo, = ([02 ]m - [02 ]out )%

VO2 = oxygen consumption rate (mg Oz/kg/hour)

F = water flow rate (I/hour)

[02]in = oxygen content in water inflow (mg O2/liter)

[0O2]out = oxygen content in water outflow (mg O2/liter)

BW = body weight of experimental animal (kg)

The advantages of this method are several:

1) the duration of the experiment is in principle unlimited
2) no accumulation of CO2 and other metabolites

3) its possible to measure at a constant oxygen level

4) by controlling the quality of the inflowing water its possible to measure metabolism at
different desired levels of oxygen, salinity etc.

However, this method bring along one significant disadvantage: in order to determine oxygen
consumption by open respirometry it is crucial that the system is in steady state. This means

that the oxygen content of the in flowing and out flowing water, AND the oxygen consumption
of the animal have to be constant.

If the oxygen consumption of the animal for some reason changes during the experiment,
steady state will not exist for a while. Not until the system is in steady state again will the
above formula give the correct oxygen consumption rate. The duration of the time lag depends
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on the relationship between chamber volume, wash-out and flow rate. Thus, open
respirometry measurements have poor time resolution and are not suitable for determination
of oxygen consumption on organisms with a highly variable respiration, e.g. like fish that can
triple their respiration rate or more within a few minutes.

10.3.3. Intermittent respirometry

AutoResp™ is based on the principle of intermittent respirometry aiming at combining the best
of both of the above methods 1) closed and 2) flow-through respirometry.

The experimental animal is placed in a sealed chamber with ports for recirculating the (closed)
volume of water inside the chamber during measurements to avoid gradients (mixing) and to
maintain adequate flow past oxygen probes with self-consumption of oxygen.

A second set of ports are used to flush the water inside the respirometer chamber
intermittently with water from the ambient tank (temperature bath) in which the chamber is
submerged to avoid severe oxygen depletion inside the chamber. Hence the name intermittent
respirometry.

A computer actuated (flush) pump connected to the latter ports is turned on and off
intermittently to flush the chamber, When the flush pump is turned off the systems operates
like closed respirometry.

When the pc controlled flush pump turns on, it pumps ambient water into the respirometer
chamber thus bringing the oxygen content to the level of the surrounding ambient water. In
this way, problems with accumulating metabolites and severe changes in oxygen level due to
animal respiration are avoided.

As with open (or flow-through) respirometry, the duration of the experiment is in principle
unlimited.

However, the most important advantage is the great time resolution of this method. Oxygen
consumption rates of animals can be determined for every 5-10 minutes over periods of hours
or days, making automated systems extremely well suited for uncovering short and long term
variations in respiration.

In summary, AutoResp™ systems for automated oxygen consumption measurements have
been developed for prolonged respirometry experiments in a controlled laboratory
environment.

To summarize, the automated measuring procedure runs in three phases:
1. Measuring period (M)

2. Flush period (F)

3. Wait period (W)

In the Measuring period (M) the flush pump is off, and the chamber is closed. Fish respiration
rate is calculated from the decline in oxygen. During this time the recirculation pump is active
to mix the water inside the respirometer and to ensure proper flow past the oxygen sensor.

The measuring period is followed by a Flush period (F) where the flush pump is active pumping
water from the ambient temperature bath and into the respirometer. During this period the
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recirculation pump is inactive and the oxygen curve will raise to approach the level of the
ambient water.

95 IIIII-

| i
07:08:24 07:28:24
Time

N

Finally, the flush pump stops and the loop ends with a short Wait period (W) before starting a
new measuring period. This waiting period is necessary to account for a lag in the system
response resulting in a non-linear oxygen curve. During the Wait period the recirculation pump
is active.

350

300 - 'I “}

4
250 v
<
S 200+ 1
= s
_ L ]
= 150 i
100 4
50
0 - [ | I | I I
12:00 16:00 20:00 00:00 04:00 08:00
Time (hh:mm)

Examples of raw MOz data can be seen from the above diagram. Standard metabolic rate of
juvenile Rainbow Trout was determined in a static respirometer chamber and with an
automated respirometry system from Loligo™ Systems during approximately 24 hours.

Initial high oxygen consumption rates due to handling stress, were followed by a gradual
decline to lower and more stable values indicating standard metabolic rate for the specimen.
Notice the high temporal resolution (10 min) of the system revealing sudden changes in MO..
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10.4 Dissolved oxygen

The oxygen capacitance coefficient B in water is only 1/30 of that in atmospheric air,
depending on barometric pressure. The concentration of oxygen in air-equilibrated water
depends on water temperature and salinity. Even more importantly, the diffusion velocities of
oxygen molecules are 10.000 times lower than in air. Thus oxygen is scarce and fluctuates due
to environmental changes in pressure, temperature and salinity.

[0,]=pO, B

[O2]

concentration of oxygen in water (mg0O2/I)

pO2
B

Atmospheric air contains c.21% oxygen, e.g. 210 mlOz/l and in general terrestrial animals is
rarely challenged by any significant changes in oxygen availability.

partial pressure of oxygen in water (kPa)

capacitance coefficient of oxygen in water (mg O2/I/kPa)

In comparison one litre of “saturated” water in equilibrium with atmospheric air, contains only
c.10 mlO2/I, and oxygen solubility will decrease with increasing water temperature and salinity
and visa versa.

Thus, many aquatic organisms experiences significant pertubations in oxygen levels in their
natural environment, and not only due to anthropogenic effects (eutrofication). In
environments with high biological activity, algae and plants can add high amounts of oxygen to
the water during daytime photosynthesis, whereas oxygen in the water is consumed during
night by the respiration of the same organisms and bacteria in some case causing severe
hypoxia.

Formulas

[02]= Pw0, -

Where

PwO?2 = oxygen partial pressure in water (kPa)
B = oxygen solubility in water (mgO2/I/kPa)

See appendix for B -values in relation to temperature and salinity.

From barometric pressure (BP) and vapor pressure (pH20) the partial pressure of oxygen in
fully saturated water can be calculated as:

p0, =(BP - pH,0)-0,2094
where 0,2094 is the fraction of oxygen in the atmosphere at sea level.

See appendix for pO2- and pH20-values in relation to barometric pressure and temperature
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11. TROUBLESHOOTING

11.1 Change Y-scale units

To change the scaling of graph y-axes, double click the upper or lower value of the Y-scale and
type a new value using the keyboard numerics.

10

9
8
7
6
5
4
3
&
1
0
1;

- | 0 0 0 D | 4-7 ] D D D D d
114512 11:45:22 11:45:33 11:45:43 11:45:53 11:46:02 11:46:13 11:45:53 11:46:03 1146313 11:46:23 11:46:32 11:46:43 11:46:52
Time Time

11.2 Noise

If a noise problem on input signals exist, users can choose a moving average function to
smoothen signals.

Owmygen [%air saturation]

92-1 1
11:02:36 11:12:36
Time

4 [0 3

Example. Graph showing raw sensor signal (red curve) and the same data with a moving
average of 10 points (white curve).
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11.3 Previous versions

It is important to remove any previous versions before installing the new AutoResp™ software:

9. Click Start->Control Panel
10. Open Programs and Features
11. Double click on National Instruments software

12. Select all packages, and then click on Remove.

-
3 National Instruments Software ==

Maodify
Change which application features are installed. Cisplays the
Select Features dialog, which lets you configure individual

Products

NI 985« Software1.3.5

NI CompactRIO 3.5.0 features.
NI CompactRIO Medule Support 3.5.0
NI FlexRIO 1.5.0 Repair

DA e e i o e AL Reinstall missing or comupt files, registry keys, and shortcuts.
NI Hierarchical Waveform Storage 1.4.8 3 Preferences stored in the registry may be reset to default

MIIVI Compliance Package 4.2 | walues
NI Instrument I/O Assistant
NI LabVIEW 2009 T

NI LabVIEW 2010 Remove product from this computer.

13.You will then be notified that AutoResp™ also will be removed. Click Yes
14. Now wait until all packages are uninstalled. This might take some time.
15. Windows will now ask for a restart.

16. When the computer is restarted, proceed to install the new AutoResp™ software.
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11.4 2-point calibration

If using an oxygen meter with an analog output connected to a data acquisition instrument
(e.g. DAQ-M/-S/-1/-4), start by calibrating the sensor against two known standard solutions.
This is often done by equilibrating a stirred water sample with atmospheric air to reach 100%
air saturation. Use an air pump to bubble the water sample and allow enough time for full
equilibration. Then place your oxygen sensor in the sample and wait for the sensor signal to
stabilize. Then follow the operating instructions for the meter to set the measured (HI) value
to 100%. Repeat this procedure for a zero oxygen solution, setting the measured (LO) value to
0%. Bubble with nitrogen gas or use a sodium sulphite solution to remove all oxygen from the
sample.

Now the oxygen meter will convert the oxygen sensor signal into % air saturation and the
correct values is displayed on the screen. Alternatively the engineering unit could be changed
to mmHg or kPa.

If the oxygen meter has an analog output, this can be connected to an A/D (analog-to-digital)
instrument, e.g. DAQ-M/-S/-1/-4 instrument, for PC data acquisition. A typical analog output
signal is a 0-5V DC voltage over the entire measuring range, e.g. when the oxygen meter
screen reads 0% oxygen saturation the analog output is 0 VDC, and when the meter reads
100% the analog output is approximately 2.5 VDC if the measuring range is 0-200% air
saturation.

To convert the 0-5VDC signal into engineering units (e.g. % air sat.) in AutoResp™, a second
two-point calibration is necessary, e.g. to convert the output signal from the instrument into %
air saturation or another unit of measure.

Place your sensor into a low solution, wait until the voltage stabilizes, then click LOCK LO and
read the value on the oxygen meter and write the value in the corresponding LOCK LO oxygen
field. Now the voltage is calibrated against an oxygen saturation.

Do the same for a high solution, but press LOCK HI.

When done, the output from the instrument is calibrated in AutoResp™.
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11.5 Run AutoResp™ always as admin
1. Right click on the AutoResp™ icon.

Choose properties.

Go to compatibility.

> wonN

Enable “Run this program as an administrator”

6]

Click OK.
6. Now open AutoResp™ by double clicking the icon.

7. Choose Yes, to confirm that you want to start the software as admin.

Next time you want to open AutoResp™ as admin only do step 6 and 7.

12. INDEX

AMBIENT WATER QUALITY ...covvviiiiiinnnen 56 Intermittent.......ccooiiiiiiiii 65
AULORESP™ i 45 Loligo™ Service Pack .......covvvviiiiiiniinnnns 36
AutoResp™ installation...........covvvvivinnnn. 31 Noise problems .................. 68; 69; 70; 71
Change Y-scale units..........covevvvieivennnn. 68 OXY=4 MiNi covviiiiiiiii i 13; 17
Closed. ..o 63 SENSOr SPOLS v 29
DAQ-M i 24 Solid blocking correction............c..c....... 54
DAQ-PAC-F1 . i 4 Static chambers ... 10
DAQ-PAC-F4 ... 6 Swim tunnels......ooveiiiiiiini 11
DAQ-PAC-F8 ...t e 8 TEMP-4 .. 25
Dipping probe .....cccviiiiiiiiiiiii 28 WiBU ..o 44
Flow-through ... 64
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13. APPENDIX

Table 1. Table of oxygen saturation in water

Temperature Air saturated water Atmospheric pressure
(deg C) (ppm or mgO, I') (mmHg)
10 11.3 157.3
11 111 1571
12 10.8 156.9
13 10.6 156.7
14 10.4 156.5
15 10.2 156.3
16 10.0 156.0
17 9.7 155.8
18 9.5 155.6
19 9.4 155.4
20 9.2 155.2
21 9.0 154.9
22 8.8 154.7
23 8.7 154.4
24 8.5 154 .1
25 8.4 153.8
26 8.2 153.5
27 8.1 153.2
28 7.9 152.8
29 7.8 152.5
30 7.6 152.2
35 71 150.0
40 6.6 148.0
45 6.1 145.5
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Table 2. Partial pressure of oxygen (p0O2) at different barometric pressures and temperatures
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Table 3. Oxygen solubility in mg O2/liter/kPa at different temperatures and sal
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